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1 General
This manual describes the unit Line Monitor as well as the software KEB Protocol Monitor V2.0.
The Line Monitor is a universal serial hardware monitor and is operated with the software described
here. Independent of that, the software can also be used with other connections such as the field bus
monitor for F4/S4.

1.1 Technical Data Line Monitor

Voltage Supply Mains 100..250 VAC via Euro Connector, 50/60 Hz
Voltage Supply Local 18..30 VDC, fed in via D-Sub15 Socket
Housing Table Unit, 100*100*60 mm
Operating Temperature -10° to +45° Celsius
Part Number Line Monitor (*) 00.F5.025-0070
Part Number Cable to the PC (included in *) 00.58.025-001D
Software KEB Protocol Monitor Freely available in the Internet: www.keb.de /

ftp.keb.de
Part Number of this Instruction Manual C0.00.01B-K200, available over Internet
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2 Line Monitor
The Line Monitor is a serial 2-channel recording unit with storage for any serial, asynchronous and
HSP5-protocols. It is connected to the PC with a KEB-Standard-COMBIVIS-cable. For the connection
to KEB control cards or operators a special adaptor (probe) is included in the delivery. As operating
and display program serves the KEB Protocol Monitor starting from Version 2.0, described further on.
The recording and reading speed and the data format are adjustable independent from each other.
Thus the Line Monitor can record for example a 250-kBaud HSP5-(full duplex)connection and output
the incoming telegrams with 38.4 kBaud to the PC successively. Depending on the telegram density
an overflow can occur in the ring storage of the Line Monitor. In that case the internal recording is
stopped, the telegrams still stored are output and thereafter the KEB Protocol Monitor is also stopped
with a corresponding error message.

2.1 Basic Unit
The basic unit contains the power pack as well as the recording electronic. The reference points GND
of the D-Sub-connectors are internally connected (no electrical isolation). The basic unit has following
connections.

2.1.1 Line Cable with Euro Connector
Serves in normal operation for the voltage supply. Voltages from 100 to 250 Volt AC can be used. If no
mains voltage is available, then DC voltage can be fed in over the D-Sub-15 Socket.

2.1.2 D-Sub-9 Socket
This is the RS232-connection to a serial interface over the enclosed cable with following allocation:

D-Sub-9 Female
2 RxD ->PC Pin 2
3 TxD ->PC Pin 3
7 GND ->PC Pin 5

Shield Cable shielding

2.1.3 D-Sub-15 Socket
Connection to the probe. All signals are executed as RS485-lines, thus the cable can be extended, if
necessary (max. 100 meter). The socket has following allocation:

D-Sub-15 Female
1 Input for supply voltage, 18..30 VDC
9 GND for supply voltage

2,8,15 GND to the probe
3,10 +5V voltage supply for probe
4,11 RS485-pair channel B receive
5,12 RS485-pair channel A receive
6,13 RS485-pair channel A Handshake
7,14 RS485-pair channel B Handshake

Shield Cable shielding

Alternatively an operating voltage can be fed in at Pin 1 and 9. In this case Pin 9 is connected with Pin
2, 8 and 15 (no electrical isolation).
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2.2 Probe
The probe contains two D-Sub-9 connector, that are interconnected 1:1, as well as high-impedance
coupling on up to 4 signal lines. Thus the probe can be plugged onto any D-Sub-9 connector/socket of
KEB-units with HSP5, RS232 or RS485 connection without influence. Switches enable the selection of
the operating mode. An incorrect adjustment, even at contacting on HSP5-interfaces with operating
voltages of up to 30 Volt, does NOT lead to damages. Connections to other interfaces can be made
with a suitable, self-made adaptor in conjunction with the correct adjustment of the operating mode.

2.2.1 Operating Mode HSP5
The probe is plugged directly between F5-control card and F5-operator or on one side of a HSP5-
extension between inverter and operator. Switches S1, S2, S3 are set to 'HSP5' , switches S4, S5 are
arbitrary.

Adjustment of the KEB Protocol Monitor:
Protocol 'HSP5' or Handshake 'Hardware, full duplex'

Picked-off and used signals
D-Sub-9 Signal and level

2 Channel B receive TTL
3 Channel A receive TTL
5 GND
7 Channel A Handshake TTL
8 Channel B Handshake TTL

2.2.2 Operating Mode RS232 KEB
The probe is plugged directly between the D-Sub-9 socket of a F4 or F5-standard operator and the
cable to the control/PC. Switches S1, S2, S3 are set to '232/485' , switches S4, S5 to '232' .

Adjustment of the KEB Protocol Monitor:
Protocol 'DIN66019II' or other 'Software' Handshake, depending on the protocol to be recorded.

Picked-off and used signals
D-Sub-9 Signal and level

2 Channel B receive RS232
3 Channel A receive RS232
7 GND
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2.2.3 Operating Mode RS232 PC
The probe is directly plugged onto a serial PC-interface (D-Sub-9 connector). Switches S1, S2 are set
to '232/485', switch S3 to 'HSP5' and switch S4, S5 to '232'.

Adjustment of the KEB Protocol Monitor:
Protocol 'DIN66019II' or other 'Software' Handshake, depending on the protocol to be recorded.

Picked-off and used signals
D-Sub-9 Signal and level

2 Channel B receive RS232
3 Channel A receive RS232
5 GND

2.2.4 Operating Mode RS485
The probe is directly plugged between the D-Sub-9 socket of a F4 or F5 standard operator and the
cable to the control/to the 485-transformer. Switches S1, S2, S3 are set to '232/485', switches S4, S5
to '485'.

Adjustment of the KEB Protocol Monitor:
Protocol 'DIN66019II' or other 'Software' Handshake, depending on the protocol to be recorded.
With bridged transmission/receive lines (RS485-2-wire or half-duplex connection) the protocol can be
adjusted to ‘Software, single channel’ to avoid double recordings.

Picked-off and used signals
D-Sub-9 Signal and level

4 Channel A receive RS485+(A)
5 Channel A receive RS485-(B)
7 GND
8 Channel B receive RS485+(A)
9 Channel B receive RS485-(B)
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3 KEB Protocol Monitor

The KEB Protocol Monitor is a PC-Software for the representation and analysis of serial telegrams of
the KEB protocol family. The software runs under WIN95/98/NT/2000 and uses a serial standard
interface of the PC for the receipt of telegrams. The incoming characters are evaluated according to
the adjusted protocol and represented line by line.
Since telegram inquiry and response are on one physical receipt line, they must be available in
chronological order without overlapping (no full duplex operation possible). This is ensured with the
DIN66019-Protocol (operation with F4-field bus adaptor). In HSP5-operator mode the connected field
bus operator ensures the observance of the chronological operational sequence. With the connection
to the Line Monitor a genuine full-duplex operation with channel assignment and time-stamp
information is possible.
The identified telegrams can be stored and reloaded and copied into the Windows clipboard for the
use in other programs. Also possible is a layer-7-decoding for the representation of parameter values
in standardized display and filtering/triggering onto special telegram contents.

3.1 View and Control Elements:

   Interface     Baud rate     Protocol decoding            Monitor functions

Status line, channel/timestamp only at Line Monitor operation
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3.2 Functions

3.2.1 Operation as DIN66019II-Monitor
In this operating mode incoming DIN66019II-telegrams are recorded for example by the field bus
monitor. In addition to the extended services the DIN66019II-protocol also contains the well-known
telegrams of the DIN66019-protocol. Click on the DIN66019II-Protocol button and select the desired
interface and baud rate. The character format (7 data bits, 1 stop bit, even parity) is accepted
automatically. In this case the switches for the monitor functions are off-state. Start the recording with
the start-button on the top left or with the key F9. The number of received telegrams is indicated in the
list on the top left, the identified telegrams are entered in the list. In order to stop press the button on
the top left or key F9 again.

3.2.2 Operation as HSP5-Monitor for Field Bus Operators
In this operating mode the interface of the PC is connected with an HSP5-adaptor cable including
adaptor on Western-connector to the diagnosis interface of a F5-field bus operator.
ATTENTION: Never connect the PC-interface without a special adaptor cable to a HSP5-
interface! It would result in the destruction of the PC-interface.

Click on the HSP5-protocol button and select the desired interface and a baud rate of 38400 Baud.
The character format (8 data bits, 1 stop bit, even parity) is accepted automatically. In addition to it
select the monitor function to be recorded on the top right:
Comm: Records telegrams of the parameterizing channel (PCP-communication/SDO-communication.
PD Out: Records the OUT-process data telegrams (from the control to the inverter).
PD In: Records the IN-process data telegrams (from the inverter to the control).
Any combination of the functions is possible. Start the recording with the start-button on the top left or
with the key F9. In order to stop press the button or the key F9 again. The number of received
telegrams is indicated in the list on the top left, the identified telegrams are entered in the list. The
column ‘ID’ contains a consecutive sequence of the telegram-ID-numbers in the range of 01h to 0Fh.
Gaps in this  sequence mean, that the operator could not output the missing IDs because of missing
buffers. This occurs frequently in the case of activated PD in functions and fast change of IN-process
data, that are read by the inverter in millisecond cycles, but which cannot be output fast enough over
the relative slow 38400-baud connection to the PC.
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3.2.3 Recording of any Data in Raw Format
In the decoding mode ‘RAW’ any telegrams can be received and represented in hexadecimal form.
The configuration of the RAW-data format (not with Line Monitor operation) takes place with the menu
item ‘Raw format settings’ in the menu ‘Settings’ or when activating the RAW-functions:

Without Line Monitor operation the telegrams are stored in blocks of 16 bytes each and output in
hexadecimal form as well as text. With Line Monitor operation the telegram-end-identification of the
Line Monitor takes effect and the telegrams are represented individually with channel and time
information.

3.2.4 Operation with Line Monitor
In this operating mode the interface of the PC is connected over a COMBIVIS-cable to the Line
Monitor. Select the desired interface and baud rate. The baud rate adjusted here should be as high as
possible, so that the stored telegrams can be retrieved as fast as possible from the Line Monitor. The
character format is adjusted automatically with Line Monitor operation. For the protocol to be decoded
choose between HSP5 and DIN66019II or RAW for a decoded representation. The adjustments
executed so far concern only the connection between PC and Line Monitor, independent of the
telegram format to be recorded. The configuration of the Line Monitor is done with the menu item ‘Line
monitor settings’ in the menu ‘Settings’ or when activating the monitor function:

Baud rate
Here the baud rate of the two channels to be recorded is defined. This baud rate is independent of the
baud rate between PC and Line Monitor. For high recording baud rates, high telegram traffic and low
readout baud rates to the PC the ring storage in the Line Monitor can overflow. This leads to an
automatic recording stop with corresponding notice.

Timestamp resolution
The resolution of the timestamp can be selected in 5 steps. A small adjustments means a finer
resolution, but in case of long telegram intervals it can lead to undetected overflow of the time counter
and thus to incorrect difference time indications. The time counter has a value range of 16 bit,
corresponding to  0..65535. An adjustment of for example 8 us permits a measuring range of  8*65535
us corresponding to 524,28 ms.
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General protocol adjustment:
Here HSP5- and DIN66019II-operation can be selected. These settings only define the telegram end
identification as well as the data format. In order to interpret the received telegrams correctly, the
corresponding protocol must be selected in the main window!
At the time of the telegram end identification a telegram is furnished with channel information as well
as timestamp and then stored in the Line Monitor.

By pressing the ‘Advanced’ button, it can be switched to the special protocol setting. At that data
format, parity and telegram end identification can be adjusted individually. These settings are only for
experienced users and require an exact knowledge of the connected hardware and protocols.

Following adjustments are possible for the telegram end identification (Handshake):

Hardware, full duplex
The telegram end is controlled on both channels by means of separate lines.
It is the operating mode for HSP5.

Software, half duplex
The telegram end is identified by the lapse of time ‘End of Telegram’ OR by receipt on the other
channel in each case. It is the operating mode for DIN66019II on RS232-lines or RS495-4-wire
connections.

Software, full duplex
The telegram end is identified ONLY by the lapse of time ‘End of Telegram’. It is the operating mode
for any 2-channel full duplex protocols.

Software, single channel
The telegram end is identified ONLY by the lapse of time ‘End of Telegram’. At that channel B is
switched off, to prevent a double recording of telegrams. It is the operating mode for DIN66019II on
RS485-2-wire connections or any 1-channel half duplex protocols.

End of telegram
The time is adjusted with changing the baud rate and indicates the time in us, after the lapse of this
time the end of the telegram is identified without further receipt on a channel. As a standard it is 5
character times, but can also be adjusted manually.

Press the ‘OK’-button to close the input window. Start the recording with the Start-button on the top left
or with the key F9. First of all the connection to the Line Monitor is established, which can take several
seconds depending on the selected baud rate (only at the initial start or in case of changing the baud
rate between PC and Line Monitor). After that all settings are transmitted and the recording is started.
As soon as telegrams arrive, they are represented as usual. To stop press the button or key F9 again.
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3.3 Program Operation

3.3.1 Representation of the Telegrams
The telegrams are represented in tabular form. With the help of the scroll bar on the right or the cursor
keys, keys page Up/Down and Beginning/End, it can be scrolled through the list. The left column
contains the telegram number, next to it the ID of the telegram is displayed. The ID-numbers are
consecutive identifiers for the assignment of response to query. Telegrams of the old DIN66019-
protocol as well as special displays have no ID-number. The column ‘Function/Service’ displays the
type as well as the used service:
Req Read : Request Read, a  value shall be read
Rsp Read : Response Read, the read value or an error code
Req Write : Request Write, a value shall be written
Rsp Write : Response Write, the acknowledgement to a write job
Select: Inverter addressing at the DIN66019II-protocol
The different services can be taken from the service description KEB-Protocols and show the type of
the service as for example writing the parameter value or reading the parameter name etc.

In the column ‘Additional’ further service-specific specifications like inverter address, parameter value
or name and, in the case of active layer-7-decoding, also the standardized parameter value are
displayed.
Via the key F12 of the menu ‘Settings->Hex Display’ the representation of the parameter value can be
changed between decimal and hexadecimal.
With the menu item ‘File->Clear’ or the key CTRL+Remove all telegrams can be deleted after further
query.

3.3.2 Plaintext Representation
For the representation of standardized parameter values and plaintext for the services 0 and 1 (layer-
7-decoder) a COMBIVIS 5-compatible parameter file is necessary (PARAxxxx.bin, xxxx=Inverter-
Software Number). By selecting the menu item ‘Settings->L7 decoder’, the function can be activated
and deactivated. If COMBIVIS is installed on the PC, then the protocol monitor finds the directory with
the parameter files automatically. Choose the suitable file to activate the layer-7-decoder.

3.3.3 Channel/Time Information
When the telegrams have been read by the Line Monitor, the channel (A or B) and the timestamp of
the selected telegrams are displayed in the lower status line.
Furthermore, the current line can be marked with the key ‘M’. By selection of another line the
difference time to the marked line is also indicated in the lower status line.

3.3.4 Export into other Applications
Entries in the telegram table can be copied as text into the Windows-clipboard. Thus it is easily
possible to use these for other applications. At that the columns are separated by tabulation markers,
the line by line make-up characters. Select the menu item ‘File->Copy’ or the keys CTRL+C and enter
the range of the telegrams. Maximally 100 telegrams can be copied simultaneously. At activated
display filtering, all filtered telegrams (max. 100) can be copied, too.
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3.3.5 Filtering
In order to display only certain telegrams out of the quantity of recorded telegrams, the adjustment
dialog for the filter conditions can be activated via the menu item ‘Filter->Set filter’ or the key F2.
With the adjustment ‘All’ one filter condition suits all telegrams. Moreover, ALL filter conditions must fit
for a single telegram, in order to select this telegram. This can lead to the fact that NO telegram
passes through the filter. In case of doubt only one filter adjustment should be attempted and the
result be checked. The filter adjustment for ‘Address’ is only possible at requests with address
specification, ‘ParameterData’ is provided for the services 0, 1 and 50 (parameter value). Process data
and scope telegram values are likewise possible only for the corresponding services, with other
services the filter condition will never be fulfilled!

The key OK closes the window and activates the settings.
With the key F3 the display can be filtered, i.e. only telegrams are indicated, that correspond to the
filter criteria. However, sometimes also adjacent telegrams are displayed, in order to see the
preceding request in the case of filtering onto a negative receipt.

3.3.6 Search
To search for specific telegrams, set the filter accordingly and place the selection bar on the telegram
entry, with which the search shall begin. Press CTRL+F to start the search in ascending order of
telegram numbers. If a suitable telegram is found, the selection bar is put on it.

3.3.7 Triggering onto Specific Telegrams
If you want to stop the recording when a specific occurrence takes place, proceed as follows:
So that after the triggering not too many telegrams are stored, you can define the maximum number of
recorded telegrams via menu item ‘Settings->Max buffer’. On exceeding this number, the oldest
telegrams are overwritten. Now set the filter according to the occurrence. Via the menu item ‘Filter-
>Trigger’ or the key F4 the triggering is activated and the number of subsequent telegrams still to be
recorded is defined. After recognition of the desired telegram the recording is stopped, if necessary
after receipt of the still following telegrams, and a reference is provided.

3.3.8 Saving / Reading
For the later evaluation the stored telegrams can be written into a file by means of the menu item ‘File-
>Save’. Stored telegrams are reloaded via the menu item ‘File->Read’. In that case the telegrams
displayed up to now get lost.


